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Introduction 

The Steel Design Tool provides the overall framework including libraries of vehicles, appurtenances, and materials 

as well as the capabilities required to analyze and design steel plate girders in accordance with the AASHTO LRFD 

specification, considering requirements for constructability, service, strength, and fatigue. 

The user can describe the overall bridge framing plan as a girder system that includes multiple steel plate girders. The 

girder system definition is limited to regular geometries with constant and equal beam spacing and the same skew at 

all supports. The tool can compute constant live load distribution factors and determine both dead loads and live loads 

for each beam based on the input provided for the girder system structure definition. 

 

Launch Steel Design Tool 

The Steel Design Tool is installed with the BrDR installation. After the BrDR installation is completed successfully, 

the Steel Design Tool is initiated by double-clicking the Steel Design Tool shortcut icon from the desktop, 

 

or select Windows Start menu on the taskbar ► AASHTOWare BrDR 75 ► Steel Design 7.5. 
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Four design project examples are provided with the installation. The design project examples (.brdx) are included in 

the same folder where the Steel Design Tool is installed. The default installation folder is C:\Program 

Files\AASHTOWare\BrDR75\SteelDesign. The following table describes the four design project examples. 

 

Design Project Examples 

File name 1_ST-3S-4G-C-

0Skw-Gr50+70.brdx 

2_ST-5S-4G-C-

0Skw-Gr50+70.brdx 

3_ST-3S-5G-C-

46Skw-Gr50.brdx 

4_ST-1S-6G-C-35Skw-

Gr50-Sdwlk.brdx 

General Description 

Number of spans 3 5 3 1 

Span lengths (ft) 140 – 175 – 140 190 – 240 – 240 – 

240 – 190 

88 – 148 – 88 66 

Number of girders 4 4 5 6 

Girder spacing (ft) 12 12 7.67 6.58 

Deck overhang (ft) 3.5 4.8675 2.3542 1.7604 

Web depth (in) 69 96 44 20 

Support skew angle 0 0 -46 -35 

Composite Yes Yes Yes Yes 

Deck thickness (in) 9.5 9.5 8 8 

Steel grade – Web 50ksi 50ksi 50ksi 50ksi 

Steel grade – Flange 70ksi 70ksi 50ksi 50ksi 

Loading 

Live load HL-93 HL-93 HL-93 HL-93 

Permit vehicle Yes Yes Yes Yes 

Fatigue vehicle Yes Yes Yes Yes 

Pedestrian load No No No Yes 
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Quick Tour 

Launch Steel Design Tool and select Open on the File tab. Open the 1_ST-3S-4G-C-0Skw-Gr50+70.brdx file provided 

with the installation. 

 

The Steel Design Tool user interface is composed of the File, Design Input and Design tabs. 
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The File tab is used to create new design projects, open existing design projects, and save the current design project. 

Print sends the design project to the printer. Recent shows a list the recently opened design projects for easy access. 

Library manages the appurtenances, materials, and vehicles for use in the design projects. Configuration allows 

modification to the configuration of new design project. Help provides access to the Steel Design Tool Help and 

technical support information. 
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Select the Design Input tab. 

 

 

 

The Design Input tab is composed of the Project, Project Library, Geometry, Deck, Typical Section Loads, Beam 

Parameters, Lateral Support, Member Loads, and Control Options input groups as well as the Input Report 

group. The data entered in these input groups are the design inputs and parameters of the design project. The Input 

Report group shows a summary report of the design input data. 

 

Select each of the design input groups to review the design input data. 

 

Validation allows you turn on and off the on-the-fly design input validation. Forward and Backward provides 

navigation among the input groups. 

  



STL14 - Steel Design Tool – Getting Started 

Last Modified: 3/3/2024 6  

Select the Design tab and click on the Design input button  to kickoff a design input run. 

 

 

 

The Design tab is composed of the Design ribbon, Design Run table, and Design Review data. 

 

The Design ribbon’s Design run group is used to start a design run. A design run can be either a design input run or 

a design review run. 

 

The Design Run table presents the beam designs for the design runs. Design run 1-I1.1 signifies the beam design is 

for Beam 1, Design input run 1 and Iteration 1. 
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Click on the  icon next to the Critical design ratio to review the Specification Checks Summary. 

 

The Design Review data represents the beam details for the selected beam design in the Design Run table. Details 

are provided for the girder profile, shear stiffeners and shear connectors (if included in the design). A profile schematic 

is also available. Each beam design in the Design Run table represents a set of Design Input data and a set of Design 

Review data. 

 

A Design input run uses the Design Input data to perform design optimization for the selected beam and the specified 

minimum design ratio. When a design input run is completed sucessfully, the optimal girder design is presented in the 

Design Run table. Design review run uses the Design Input data and Design Review data to perform design review 

for the selected beam. When a design review run is completed sucessfully, one girder design will be presented in the 

Design Run table. 

 

The Design ribbon’s View results group is used to open the Specification checks, Tabular results, Result graphs, 

amd Engine outputs for the beam design selected in the Design Run table in the Results window. 

 

 

Select design run 1-I1.1 and click on the Specification checks button to open the Specification checks window. 

Double-click on the specification articles to review the detail specification checks. 



STL14 - Steel Design Tool – Getting Started 

Last Modified: 3/3/2024 8  

 

 

 

Click on the Tabular results button, Result graphs button and Engine outputs button to open the corresponding 

windows. 

 

The Design ribbon’s Input and Review group and BrDR group are used to manage the Design Input data and Design 

review data of the selected beam design in the Design Run table. 
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Export/Import functionality between Steel Design tool and BrDR 

Click on the Pin icon to select the design run to be exported and then click on the Export button to export the girder 

design to a Bridge Design Input file (.brdi). 

 

 

 

  



STL14 - Steel Design Tool – Getting Started 

Last Modified: 3/3/2024 10  

Launch BrDR and select New from Bridge tab of the Bridge Explorer ribbon to create a new bridge. Enter SDT1 as 

the Bridge ID and the NBI Structure ID. Click OK to close the Bridge Description window. Select 

SUPERSTRUCTURE DEFINITIONS in the Bridge Workspace and click on the Import Design Tool button on 

the TOOLS ribbon (or right click on SUPERSTRUCTURE DEFINITIONS and click on the Import Design Tool 

File from the drop-down menu)  
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Select the .brdi file exported from the Steel Design Tool in the previous step. The Import Design Tool File window 

opens as shown below. Select design run 1-I1.1 import, check the Import? checkbox and click on the Import button 

to import the beam design into BrDR. 

 

Click Close to finish importing the bridge. 
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Design Algorithm 

The steel design tool first searches for a design which satisfies all AASHTO LRFD specifications. If an acceptable 

design is found, the design tool attempts to improve upon the design by reducing the section dimensions. The optimal 

design is the design with the smallest total steel volume with design ratios greater than the minimum design ratio 

entered by the user. 

  

The steel design tool allows the user to define the range of dimensions and the increment within the range for the plate 

girder dimensions. For each flange, the user can input the minimum and maximum dimensions for the width and 

thickness. For the girder web, the user can enter the desired depth as well as the minimum and maximum web 

thicknesses. The user can also enter the increment by which they want each dimension to vary within the design. 

  

Maximum Dimension Check 

The first design trial always performs a maximum dimension check. It uses this initial check to determine whether a 

design is possible for the provided plate dimension ranges, superstructure geometry and vehicle loading. The design 

tool builds a trial model by assigning the maximum dimensions to the web and flange plates along the entire length of 

the girder. If this initial design does not satisfy the minimum design ratio criteria, the design tool will stop further 

design trials and output the results from this maximum dimension check. If the user encounters this situation, it is 

recommended they increase the web depth for the plate girder, increase the upper limits for the girder design ranges, 

or modify the superstructure geometry.  

  

When establishing the plate girder dimensions for the maximum dimension trial model, the design tool may reduce 

some of the plate dimensions to ensure that the initial trial satisfies the proportionality limits from AASHTO LRFD 

6.10.2. Often, no adjustments are required to satisfy these limits. The primary purpose of the maximum dimension 

check is to determine whether a solution exists with the range entered that will provide sufficient flexural capacity. 

This proportionality adjustment ensures the initial trial does not fail due to proportionality constraints despite having 

adequate flexural capacity. 

  

After determining the dimensions for the initial trial, the design tool analyzes the girder and checks the AASHTO 

LRFD specifications to determine if this maximum dimension design satisfies the minimum design ratio. 

Proportionality, constructability, permanent deformation, flexure, and fatigue limits are checked at this point. The 

design tool does not review the shear criteria at this stage. The web plate thickness may provide enough shear capacity 

to satisfy the AASHTO LRFD shear specifications, but this condition is not required because the design tool will 

design web stiffeners in later design trials if the web shear capacity is not sufficient.  

  



STL14 - Steel Design Tool – Getting Started 

Last Modified: 3/3/2024 13  

Initial Member Selection 

The design tool uses the results from the maximum dimension check to determine the flange plate transitions and the 

initial plate dimensions for each of the design ranges between transitions. For girders with statically indeterminate 

support conditions, the transition locations are determined from the uniform load contraflexure points from the 

maximum dimension trial. For single span girders on simple supports, the flange transition locations are always set at 

20% and 80% of the span length. In both cases, transitions are rounded to the nearest half foot. Once determined, these 

transition locations are used for the remainder of the design process.  

  

There are three different ways the initial dimensions for each range are determined. If the critical design ratio for the 

maximum dimension check is within 10% of the minimum design ratio set by the user all the design ranges will be 

set the same as in the maximum dimension trial. In this case, the initial design is close enough to the design ratio limit, 

it is most efficient to continue from this initial set of maximum dimensions. 

  

If the critical design ratio from the initial maximum dimension check is not close to the minimum design ratio, then 

the initial dimensions are determined differently for the positive flexure ranges and negative flexure ranges. For these 

two cases, the flange widths are set to the minimum flange widths. The web thickness is set to the minimum web 

thickness. For positive flexure regions, the top flange thickness is set to its minimum value and the bottom flange 

thickness is set to the average of the minimum and maximum value. For negative flexure, the thickness of both flanges 

is set to the average of the respective minimum and maximum values. 

  

If the user enables the shear stud design option, the design tool will assign shear stud ranges to the member. When the 

user wants to provide studs in the negative flexure regions, the shear stud ranges extend from the end of each span to 

the maximum moment locations determined by applying a uniform load on the beam for the initial trial. If the user 

does not wish to provide studs in the negative flexure regions, the shear stud ranges extend from locations of maximum 

moment to zero moment. 

  

Design Live Loads 

To improve performance, the design tool implements two simplifications to the loading during the design trials. First, 

the design tool reuses vehicle live load results between design trials. The plate dimensions change for every design 

trial, but the girder span lengths, girder spacing, skew and deck geometry remain the same. Because the superstructure 

geometry does not change between trials and this geometry has the largest impact on live load actions, the live load 

results are assumed to be similar between trials. The live load analysis is a time-consuming process and this assumption 

reduces the total design time. For indeterminate structures, however, the structural stiffness influences the member 

forces. Therefore, for multi-span girder designs, the member actions from live load forces may slightly differ between 

trials as the girder stiffness changes. This difference can be significant enough to shift a design from passing to failing 

when the critical design ratio is close to the minimum design ratio. If this occurs, the design tool will recompute live 

load actions for each trial until the design is satisfactory. 
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The second modification to the live load is specific to notional vehicles with multiple load cases, such as the LRFD 

HL-93 design vehicle. During the design process, the load cases for each notional vehicle combination are replaced 

with a single envelope load case, which represents the critical results for each element in the finite element model. 

Both live load simplifications are used within the design process, but during the final design trial the live load is 

recalculated to ensure the final design is satisfactory. 

  

Design Process 

The steel design tool checks the AASHTO LRFD specifications for each design trial. If any criteria fail, then the 

design tool increases the appropriate dimension until those criteria are met. The design tool works in the following 

order: 

  

1. Proportionality LRFD 6.10.2 

2. Constructability LRFD 6.10.3 

3. Permanent Deformation LRFD 6.10.4 

4. Flexure LRFD 6.10.7. 6.10.8, APP A6, APP B6 

5. Shear LRFD 6.10.9 

6. Fatigue LRFD 6.6.1.2.2, 6.10.5.3 

  

The design tool first checks the proportionality requirements. It will continue to increase section dimensions and re-

evaluate the girder until all proportionality constraints are satisfied. The tool then considers constructability. If any 

updates are made to satisfy constructability limits, the design returns to the proportionality checks to ensure those 

requirements are still satisfied. Once both proportionality and constructability limits are satisfied, the tool moves on 

to the short-term section, where permanent deformation, flexure and shear are designed. Again, if any updates are 

made to satisfy short-term section requirements, the design tool returns to check previous proportionality and 

constructability requirements. The design tool repeats this process again for the fatigue requirements. If the design 

options for appendix A6 or moment redistribution are selected by the user, the design tool will modify the girder 

sections to satisfy the relevant LRFD requirements to use these analysis methods. The appendix A6 requirements are 

checked prior to designing for the short-term section requirements and the moment redistribution requirements are 

checked after designing for shear and stiffeners but prior to designing for flexure. With each section update, the design 

tool recomputes the dead load actions using the updated girder dimensions. 

  

When the design tool conducts shear design, bearing stiffeners are added to the support locations. The bearing 

stiffeners are designed based on article 6.10.11.2. 

  

When the user opts to not use transverse stiffeners, no transverse stiffeners will be added to the steel girder. The design 

tool will check the shear limit for all the points of interest along the girder length. If the shear requirement is not met, 
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the web thickness will be increased, and the shear requirement will be re-evaluated. This process is repeated until the 

shear requirement is met. 

  

When the user opts to use transverse stiffeners, the design tool will check the shear limit for all the points of interest 

along the girder length. If the shear requirement is not satisfied, the web thickness will be increased, and the shear 

requirement will be re-evaluated. If the web thickness reaches the maximum dimension entered by the user and the 

shear requirement is still not satisfied, the design tool will add transverse stiffeners to increase shear resistance. 

Otherwise, no transverse stiffeners will be added. The transverse stiffeners will first be added to the diaphragm 

locations (if exterior diaphragms exist). Then, the shear limit will be checked at supports. If the shear requirement is 

not satisfied at supports, transverse stiffeners will be added to form the end panels. After that, the design tool will add 

interior transverse stiffeners if the shear requirement is not satisfied for any point of interest along the girder length. 

If there are stiffeners that are too close to each other, the design tool will increase the spacing between the stiffeners 

based on the minimum spacing requirement, which is determined based on LRFD equation 6.10.9.3.2-4. 

  

When increasing section dimensions, the design tool uses the increment defined by the user. The update methods also 

utilize information about the current and minimum design ratios to take larger steps when appropriate to speed up 

convergence. For each design trial, the design tool will merge adjacent ranges for webs or flanges if the respective 

dimensions are the same. 

  

If the design tool reaches one of the upper limits and is still unable to satisfy the design requirements, the design tool 

will stop further design trials and return the best available design. At early stages in the design process, the best design 

may be the maximum dimension trial because this is the only design which satisfies all of the LRFD specifications. 

  

Minimizing Design Weight 

For most configurations, there may be many possible girder designs which have design ratios close to the minimum 

design ratio. The design tool searches for the design in this set which has the lowest total steel volume. Steel volume 

is assumed to provide a good estimate for the cost of a particular design and is directly proportional to the total weight 

of the girder. 

  

When the design tool finds a design that meets all of the LRFD requirements, it computes the steel volume for this 

successful design trial. The design tool then reduces the plate girder dimensions and redesigns the girder. If multiple 

successful trials are available, the design tool uses the information from the previous design ratios and input 

dimensions to inform the section reduction, otherwise all dimensions are reduced by one step. 

  

After redesigning each reduced section, the reduced section volume is compared with the previous volume. While the 

section volume is decreasing, the design is improving. Once the volume stops decreasing, the design tool has found a 

minimum point, which it considers to be the optimal design.  
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Final Design Check 

A final design trial with the full live load is performed on the optimal design. During this step, if the user enables the 

shear stud design option, the shear stud wizard is  used to develop the shear stud patterns. Placeholder studs set for the 

initial ranges are replaced with the actual designed shear stud. If the shear stud design tool is unable to find a design, 

the top flange widths are increased until a design can be found. 

  

The design tool determines the best design which can be achieved by modifying the design variables, such as the plate 

dimensions. Occasionally, the final design may fail a specification article that cannot be readily fixed by modifying 

the design variables. In these cases, it is recommended the user review the specification results and adjust their inputs 

accordingly. One example is the LRFD 6.10.1.7 specification for minimum negative flexure concrete deck 

reinforcement. If this article fails, the user should revisit the inputs for the deck reinforcement and increase the rebar 

in negative flexure regions to satisfy the minimum steel area requirements. 
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